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PHOTOSHOP MASTERCLASS VIDEO EDITING MASTERCLASS 

FOR THOSE WHO EDIT video for a

living or for anyone that likes to

produce good clean edited movies, the

wonders of the modern Mac has made it

possible for you to become the next Martin

Scorsese. But although you may have the kit,

do you have the talent, ideas and skill? Editing

is arguably the key to good program making,

and many a bad set of rushes has been saved

by the skill of a good editor.

So what makes a professional production

look professional? A good movie looks good

because you don’t see the screen, you look

beyond and just see the action. A good editor

should be able to make the editing as

transparent as possible so the viewer is not

distracted.This is achieved by observing

certain rules such as continuity between shots,

the use of simple transitions and the building

of natural rhythm within the edit.This is all, of

course, providing you have something worth

editing in the first place.

For the professional editor, the tools he or

she uses are crucial to the workflow but for

less demanding situations, less professional

tools can fit the bill very adequately. If you

can’t afford Avid or Media 100 systems you can

achieve equally good results with more

budget programs such as Premiere or

CineStream, although maybe with a little more

time and effort involved.There are many ways

of working on an edit – some leave you

confused and pulling your hair out and others

just take far too long either way and will not

improve the end result. Here are a few

common-sense ideas that may ease you

through the process.

BEFORE YOU START
The most important part of any production is

planning. If a shoot is well planned and

organised and the shooting script is adhered

to then the job of editing will be that much

easier. From the rushes an edit decision list can

be produced; this should match, shot by shot,

the original shooting script plus any

amendments. If a storyboard or shooting

script was not used then it can be useful to

create a rough outline from the rushes for the

purposes of timing and continuity.

A timecoded edit decision list (EDL) can be

used by most editing systems to accurately

batch-capture all the individual clips.The EDL

can be created in several different ways,

depending on the editing system you are

using. If you have limited access to the editing

facilities or are hiring them then many systems

will support imported EDLs.

The simplest EDL can be created as a text

document – this can be written on any

computer and is usually in the form of Reel

number, Timecode in, Timecode out, clip name

and a comment, each piece of information

being separated by a tab. But check that the

system you are going to use supports this and

the format is the same.

Creating an EDL by sitting in front of a

monitor and writing down the in and out

points from a burned in timecode copy can be

laborious. Luckily most editing packages have

their own way of doing it, usually in the form

of a Clip Logging window, which lets you scan

through the tape so you can select the in and

out points as you go.You can usually allocate a

file name and a comment to each clip.

Using an EDL and batch capturing all the

clips together can save you a lot of time. Once

set up, you can basically leave the system to

work on its own – until it’s time to change

tapes, that is.

This is not the only useful way to capture

your footage, and if the edit is to be less

complicated and most of the shots on the tape

are to be used, then it can be easier to capture

the whole tape. However, it’s not advisable to

capture the footage as one single file as this

can be considerably more time-consuming. A

quick method is simply to create a rough EDL

using the break points between each shot as

your guide, making sure you comment each

clip to aid identification, then batch-capture

the whole lot.

A much more effective method is using a

system that supports automatic scene

detection.This is a feature in some editing

packages such as CineStream or CatDV 1.5 from

Square Box Systems, and can be bought as a
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You’ve shot your footage, and now you’re faced with the

daunting task of making a coherent film out of it. Get a head start

and read Chris Rosser’s professional tips before you go any further.
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You can get a plug-in for After Effects which can make your video footage look as if it
was shot on film.

Cleaner5 – From: Media100

Web: www.media100.com, Price: $599

Cleaner 5 is probably the default pro tool 

for preparing video for distribution other than

on tape. It cleverly incorporates all the

authoring tools available for QuickTime,

RealNetworks and WindowsMedia into one

clever and easy-to-use interface. In addition it

has plenty of tools that help you to get the

compression and quality just right.

RealProducer – From: RealNetworks

Web: www.real.com, Price: Basic: free, 

Pro $199

RealProducer provides everything you need for

creating RealMedia streaming content. Upgrade

to the pro version to get Surestream and some

higher quality settings.

QuickTime5 Pro – From: Apple

Price: $29.99, Web: www.apple.com

QuickTimePro lets you resize and reformat your

movies to a variety of different file types using

different codecs which also let you create true

streaming. There are also effects and filters

that can be added.

Video compression
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separate utility. It will automatically run

through a tape and find the start point of each

clip – CatDV will also give a thumbnail of the

first frame of each clip and give you the option

of selecting it for capture or not.The whole

tape can then be batch-captured, saving each

clip out as a different file (for this to work

properly, it requires a continuous timecode).

BIN IT
Once all the footage is captured you can

usually import the clips directly into a bin

within a project. Bins have huge organisational

potential and programs such as Final Cut Pro2
have taken this one stage further with a media

manager.This not only lets you organise

different media clips into separate bins but

gives easy access to a whole host of useful

utilities that really help you to organise your

disk space, as well as other utilities for

recapturing clips at different resolutions and

automatically trimming and deleting unused

frames from source clips.

Bins are an essential part of an edit and

enable you to split up your clips into different

sections; you can store media types or, more

usefully, divide a project into chronological

parts. From the bins you can usually open each

clip into a trim window, where you can clean

up the in and out points before putting it on

the timeline. Premiere comes with the useful

facility to multi-select the clips from a bin in

the order you want them to appear and the

program lays them down on the timeline for

you.You also have the option of staggering the

amount of overlap between the A and B

tracks, and you can even specify a default

transition to be inserted automatically

between each.

OFF-LINE EDITING
For those of us who are not equipped with

multi-stream video accelerator cards,

producing a complex project with overlays and

multiple transitions can be a nightmare.With

many programs, including Premiere, if you want

to see how an effect or transition will look you

need to build a preview, which can be very

time consuming depending on the complexity

and duration of the effect. If, when you view

the effect, it’s not quite right and you wish to

change the duration or move it a couple of

frames, you need to build a whole new

preview. A way round this is to produce an off-

line edit, which is done by capturing your clips

at low quality or at a reduced frame size

setting.This will make any manipulation work

much quicker and in some cases almost in real

time, which has a huge advantage for the

more experimental program maker and

improves the workflow dramatically.

When the edit is complete, an EDL of the

used clips with precise timecode in and out

points can be created and exported for use in a

different edit suite (for instance, producing an

off-line edit in Premiere and exporting an EDL

for use in Media 100).

In several programs, including Final Cut Pro
and Premiere, when the off-line edit is up to

scratch the whole project can be batch-

recaptured at full on-line quality and the off-

line clips automatically replaced on the

timeline (this only works if timecode is being

used).This process also maintains all the

effects graphics and transitions.The whole

project will, of course, have to be re-rendered,

but it can be left to cook overnight if necessary.

EFFECTS
Sometimes video can look too much like video

– the image can look too sharp and clean.This

can suit corporate videos or material for web

streaming, but if you’re trying to be a little

more creative you may want your production

to look more like it has been shot on film.

There are several post-production effects

plug-ins you can use to generate some very

The batch window shows all the clips you have specified for capture. At this stage you can reorganise the clips delete them or export the
batch as an EDL.

Adobe Premiere 6.0 – From: Adobe

Price:£540, Web: www.adobe.com

The much-loved and greatly improved

version 6 has everything you need for

producing top-quality movies.

Integrated well with several budget

accelerator cards to speed things up.

CineStream – From: Media100

Price: £399, Web: www.media100.com

An excellent all-round editing software

package which has been optimised for

producing Web movies and fully

integrates with Cleaner5.

Commotion – From: Pinnacle

Price: $995 (£663), Web:

www.puffindesigns.com

An effects and compositing package

powerful enough to rival After Effects.

Includes motion tracker, travelling

mattes, unlimited layers and primatte

keyer. Not as well supported as AE, though.

See our review on p68.

Final Cut Pro 2.0 – From: Apple

Price: £799, Web: www.apple.com

FCP is the editing package Mac video

editors have all been singing about. V2

has ironed out a few initial problems,

making this an excellent choice for

beginners and professionals alike.

After Effects 5.0 – From: Adobe

Price: £617, Web: www.adobe.com

After you have put the movie together

you may need to add some special

effects and fancy title sequences. After

Effects comes built in with a whole host

of compositing tools but just look on

the web and you’ll find thousands of

third-party plug-ins that will make it

do just about anything.

Which software to use?

Final Cut Pro lets you add markers to the timeline, making cutting video to a music
beat very easy.

VARIABLE SLO-MO IN AFTER EFFECTS
Enable Time Remapping from the Layer menu for the layer you
want to add the effect to. Open the Layer window and adjust the
Remap-time marker against the Current-time marker wherever
you want the motion speed to change – this will add keyframes
to the timeline. These can then be tweaked manually to finish off,
and for better results, turn on Frame Blending.

SHOOT A COMPUTER MONITOR
There are several ways to shoot a computer monitor avoiding on-
screen black bars and flickers. The most effective is to use clear
scan – a fine shutter-speed tuning system available on most pro
cameras which can be set to match the monitor’s refresh rate.
Failing this you can try to reset the monitor to 50Hz. If this option
isn’t available, try shooting a plasma screen, such as on a laptop.

CUTTING TO THE BEAT IN FINAL CUT PRO
First open your audio clip in the Viewer window. As you play the
track through, press the M key in time to the music or whenever
you want to place a marker. When finished, put the music track
onto the timeline. With the Snapping option enabled, edit your
clips to the markers or use the Fit to Fill and the Slip tools for
accurately lining up the clips.

TIPS
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impressive results. CineLook, for example, has

many filters and subtle effects, including a

whole host of different film grain effects and

colourings, as well as less subtle effects like

scratch and dust. Cinematic effects can be

achieved on camera, for example using

progressive scan if your camera has this

feature.This effectively de-interlaces the video,

which makes each frame cleaner but creates a

flickery effect which can look like film.

AUDIO EDITING
Cutting to the beat is an essential part of any

music video edit.This can be very tricky as you

only need to be a couple of frames adrift

before the illusion of the movement of the

video to the music is lost.The easiest and most

accurate method of getting precisely on the

beat is to lay the audio track down first, then

go through the track and add a marker (you

will need a program that offers this facility) on

the timeline to every appropriate rhythm

point throughout the track.The clips can then

be dropped onto the appropriate marker.

KEEP IT CLEAN
One thing that can really cause problems on

an editing system is a fragmented hard drive.

This can happen when files are continuously

added and removed, which can leave the

computer searching those extra few micro-

seconds – enough to cause some real

problems such as a sluggish system and even

dropped frames. So it’s worth doing a defrag

on a regular basis.

RUNNING OUT OF SPACE
Storage space is a problem for the amateur

and professional video editor alike. In the past

you needed massive RAID towers of expensive

SCSI drives, and for true broadcast systems this

is still an advisable option. However if you’re

not a broadcast company then modern IDE

drives are fast enough to cope with most

editing situations and are more than enough

for capturing DV or DVCAM.This offers some

real advantages and not only in cost. External

FireWire drives make an excellent choice for

additional storage – not only do they have

massive capacities and speed but you can

daisy-chain them together.Their portability

also has advantages in that all the clips for an

edit can be captured to the drive on a non-

specialist system and then taken to an edit

studio and plugged straight into a high-end

system for editing. MF

COPYING EFFECTS IN PREMIERE
If you’ve just set a clip up with filters or effects in Premiere 6 and
you want to apply the same set up to other clips, then select the
original clip and copy it. Select the new clip or multi-select several
and go to Paste Attributes on the File menu. This will open a
dialogue box that will let you paste any effect you have applied
to all the clips you have selected.

MASKING IN PREMIERE 6
When Keying in Premiere 6, if there are elements in the frame
that you don’t want to appear over the background, you can mask
this area off. Select the clip, then from the Clip menu go to Video
Options > Transparency. Choose the type of Key from the pull-
down menu, then in the preview window drag the small handles
in each corner to the area you don’t want to show.

COLOUR BARS
If you‘re sending your master to a dupe house for reproduction
you can guarantee more accurate colour reproduction and audio
levels by adding colour bars and a test tone at the beginning of
the tape. Several editing programs have this feature built in.
Alternatively, try Test Pattern Maker from www.synethic-ap.com.
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How to make great
short feature films
Ian Lewis
ISBN 0 24051 624 9
£19.99
The making of a 20-
minute feature film
from concept to
editing.

Guerrilla TV
Ian Lewis
ISBN 0 24051 601 X
How to produce
video for broadcast
and actually get it 
on the TV.

Digital Compositing
in Depth
Doug Kelley
ISBN 1 57610 431 1
£34.99
The bible of video-
compositing for the
more experienced
and professional
editor.

Web resources
www.fcp411.net/
A great site for Final
Cut Pro users. There
are many active
forums with lots of
help at hand for any
problems you might
be having.

www.dvcentral.org/
An independent site
full of reviews and
features relating to
the DV video format.

GOING
FURTHER

CatDV is a great capture utility for DV users. It will create a thumbnail image of the first frame of each
new clip, you can select the ones you want and it will batch capture them for you.

Bins organise your clips into useful sections which
can take some of the confusion out of a large edit.

Expert advice
PAIN-FREE ON-LINE EDITING: AN INSIDER’S VIEW FROM
ROSS BRADLEY OF OCHREON PRODUCTIONS 

Being given an EDL in an on-line suite is often

a nerve-racking moment. All too often, what

seemed like a perfect edit on the off-line

machine, turns into an editing nightmare, 

with thousands of untraceable shoots. To

reduce edit suite stress, here are a few tips to

help make life easier.

If you are using analogue video, capture

footage for your offline with Burned in Time

Code (BITC). It looks messy on the screen, but

can be a life-saver if you need to trace 

shoots back on a corrupt EDL. A visual record 

of the shot is far easier to trace than a 

string of numbers.

If you use DV and edit with FCP, you can use

Video Filters > Video > Timecode Print (reader

mode) to produce the same result.

Mark each tape with your chosen reel

number and log it into your notebook as well

as your edit programme. Many editors will also

add a project abbreviation too. For example,

for a project on bumper cars, tape 1 would be

logged as Bump001.

Laying out your audio on your timeline can

also help your EDL. For example, location audio

and dialogue is kept on track 1 (it’s also easier

to see if it’s out of sync this way), Voice Over

on track 2, Sound Effects on tracks 3 & 4 and

Music on 5 & 6. If, in the on-line, there is a

problem with a clip on track 2, you will

instantly know it’s a problem with the V/O. 

It’s also worth bearing in mind that some older

on-line suites can only accommodate a total of

six audio channels. 

Computer graphics are not traceable on EDLs,

so if you want to add them in at the off-line

stage, the best way to solve this problem is to

print the graphics to tape and recapture them

as you would for a video file.

Producing the final EDL takes up very little

disk space, so it is often wise to produce a EDL

in each format (Sony, CMX or Grass Valley) as

some EDLs work better on certain edit suites.

When you hand over your disk of EDLs to

your on-line editor, also hand over copies of all

your notes, a VHS tape of your off-line with

BITC, and a paper print out of your EDL. 

This will make your on-lining experience as

pleasurable and, hopefully, as cheap an

exercise as possible.

Premiere 5
After Effects 5
CineLook
Commotion
RadiusEditDV
CatDV 1.5

On the CD
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